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Basic Features 
Calspex can create professional calibration and GR&R reports.  Calspex enables you to be accurate and consistent, 
with little effort.  If you are unfamiliar with the basic features of Calspex, browse through this Basic Features section 
before embarking on the report-writing process. 
 
The Toolbar and Tool Tips 
The toolbar grants you quick and easy access to some of Calspex most popular features. 
 

 
Figure 1: Calspex Toolbar 

 
To learn the function of a particular button, simply rest your cursor on the button until the tool tip appears, providing 
you with a short description. 
 
The Menu Bar 
The menu bar appears at the top of your screen and contains all the options available in the toolbar, plus many 
more. 
 

 
Figure 2: Calspex Menu Bar 

 
When you click on any of the words in the menu bar, a pop-up menu appears, providing you with multiple options 
from which to choose. 
 

The letters you see underlined in the main menu and pop-up menus inform you of the various 
shortcuts with which they can be accessed. 

 
The Flowchart 
The flowchart that accompanies all calibration reports is an important feature of Calspex.  It can be seen to the left as 
you complete a report. 
 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 3: Calspex Flowchart 

 
Think of the flowchart as the framework of a calibration report.  It maps out the main sections of a report and displays 
the sequence of events for a specific calibration.  Furthermore, clicking on the various boxes of the flowchart allows 
direct access to the corresponding sections of the calibration report. 
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When you begin a report, all text in the flowchart is white.  As you complete the various portions, the 
corresponding text become yellow. 

 
The Notepad 
The Notepad is useful in that it serves as a built-in word processor.  It allows you to write text, edit reports, and 
create reports.  To access the notepad, click Tools in the main menu and select Start Notepad. 
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Starting Up Calspex 
When you first open Calspex, the following screen is displayed. 
 

 
 
Figure 4: Calspex Welcome Screen 

 
The Welcome Screen directly launches the user to Calspex most popular functions, thereby bypassing the usual 
steps. 
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Gage Types (GDF’s) 
Before you begin entering data you must learn how to navigate and maintain your Gage Types, which are also 
known as GDF’s (Gage Definition Files).  One of Calspex most useful features is its ability to “learn” the types of 
gages you want to calibrate and the types of reports you want to generate.  When you choose to define a Gage 
Type, you basically teach Calspex about the properties of your gage.  They might include the types of Datasets you 
wish to include (if any), or any necessary parameters you would like to see included in the calibration report.  Gage 
Types are essentially detailed templates that are used to create calibration reports. 
 
Creating/Editing Gage Types 
To define a new Gage Type or edit an existing one: 
Step 1: Select Gage Types from the Menu Bar. 
 
Step 2: Select one of following options: 

 New…if the gage you are defining is new and unique; unlike any other.   
 Derive…if the gage you are defining is derived from, or shares the characteristics of a previously 

defined Gage Type. 
 Edit…if you are editing the properties of a current Gage Type rather than defining a new one. 
 Delete…if you wish to delete an existing Gage Type. 

 
Step 3: If you select New or Derive, enter the title of the Gage Type in the New Gage dialog box.  Then click OK 

or press the Enter key. 
 

If you are defining a new Gage Type, skip the following step. 
 

Step 4: Select a Gage Type from the Select Gage Type list.  Then click OK or press the Enter key. 
Notice that you have retrieved the Gage Definition window.  The Gage Type name is displayed in the Gage Title field 
and the .gdf filename is displayed in the title bar.  The Gage Definition window has seven tabs on the left-hand side. 
 

You define your Gage Type by clicking on 
each tab and choosing from the options 
provided. 
 
Feel free to skip tabs if they do not pertain 
to your particular Gage Type. 
 
Defining your Gage Type essentially entails: 

 Teaching Calspex about the 
properties of your gage 

 Setting up certain defaults to 
be active each time you create 
a new report using the Gage 
Type 

 Instructing Calspex to prompt 
you for certain information 
each time you use the given 
Gage Type 

 
 
 

 
Figure 5: Gage Definition Window (Properties Tab) 

 
Keep in mind that even though you establish certain defaults here, they are by no means set in 
stone.  During the calibration report process, you are able to skip functions or modify information. 
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The Properties Tab 
The Properties tab allows to you to choose which primary features you will use when creating a new calibration 
report.  Does your gage have numerical values to be measured?  Do you want to track repairs on this gage?  Do you 
want to be prompted for all datasets at once?  Are there specific procedures you want to follow during the calibration 
of this gage?  These are the types of questions you answer in the Properties tab. 

 
To establish properties: 
Step 1: Click on the Properties tab, if it is not already displayed. 
 
Step 2: Check the first check box if the Gage Type has numerical values to be measured during the calibration.  

All numerical values are measured in Datasets.  You will have master/nominal values and 
measured/actual values. 

 
Step 3: Check the second check box if you want to track and report any repairs performed on this type of gage. 
 
Step 4: Check the third check box if you want the flexibility of defining different tolerances for each Dataset. 
 
Step 5: Determine the type of Dataset prompt by clicking one of the two radio buttons: 

 Prompt for all Datasets at once…Selecting this option instructs Calspex to display all Datasets in a 
selection screen where you can select which Datasets will be used in the report at the beginning of the 
calibration. 

 Prompt for all Datasets interactively…Selecting this option instructs Calspex to prompt for each Dataset 
as they occur throughout the calibration. 

 
Step 6: Setup the Calibration Interval Type for this type of gage: 

 Normal (Time Based)…Select this option if you want to recalibrate this gage based on a specific time 
period (e.g. Every 6 months).  Set the Next Calibration Increment to the number of days applicable. 

 Actual Usage Based…If you are using or are going to use Gage Tracking (see Recall Database), you 
can recalibrate gages based on the amount of actual usage on the gage.  Enter the number of hours 
that the gage can be used until it needs to be recalibrated. 

 Part Number Based…This option should only be selected when using Gage Tracking (see Recall 
Database).  It will monitor how many parts this gage has been used on, and then flag it for recalibration 
after a specific number of parts have been reached. 

  
The following step is optional: 

 
Step 7: Click on the Calibration Procedure button to include specific procedures you wish the user to follow 

during the calibration process.  Notice that you have retrieved the Calibration Procedure window. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 6: Calibration Procedure Window 
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Only ASCII text can be entered (or pasted) here. 
The Gage Info Tab 
This tab allows you to define default values for the Gage Info screen that appears during a calibration report.  
Entering information in this screen (such as the Gage Description, Model and Location) allows Calspex to display 
that information by default each time you use the Gage Type to calibrate a gage.  If there is no default information to 
enter, you may skip the following steps.  These fields can be left blank. 
 

Information entered here becomes the default information for each gage of this type.  It can be 
modified while entering a calibration report. 

  

 
 
Figure 7: Gage Definition window (Gage Info tab) 

To establish gage information: 
Step 1: Click the Gage Info tab. 
 
Step 2: Type the gage’s prefix in the Control # field. 
 
Step 3: Press Tab to move to the Manufacturer field and enter the gage’s default manufacturer or select one from 

the drop-down list.  See the Mfg & Models Tab in Preferences for instructions on how to customize these 
drop down boxes. 

 
Step 4: Tab to the Model field and enter the gage’s default model or select one from the drop-down list.  The 

Model field could include information such as a model #, size, gage type, etc. 
 
Step 5: Tab to the Serial # number field and enter the gage’s default serial number or manufacturers’ serial 

number. 
 
Step 6: Tab to the Gage Desc field and enter the gage’s default description. 
 
Step 7: Tab to the Location field and type the gage’s default location.  
 
The Parameters 1 and Parameters 2 Tabs 
These two tabs allow you to establish certain parameters for your Gage Type.  Parameters are general features (as 
opposed to numerical values), which need to be verified and/or recorded on a calibration report.  Threaded plugs for 
instance, might have the following parameters: 

 GO thread size 
 GO MOW size 
 NOGO thread size 
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 NOGO MOW size 
 
The Parameters 1 tab and the Parameters 2 tab function the same way.  The first tab allows you to list the 
parameters to appear before entering numerical data (if any) in a calibration report.  The second parameter set 
allows you to list the parameters to appear after entering numerical data (if any) in a calibration report.  
 

 
 

       Figure 8: Gage Definition Window (Parameters 1 Tab) 
 
To establish parameters: 
Step 1: Click on either the Parameters 1 or Parameters 2 tabs. 
 
Step 2: Click the Add button.  Notice that the word BLANK appears highlighted in the both the dialog box and the 

text field below it.  Simply type the desired parameter directly over the highlighted text.  Continue clicking 
the Add button to repeat the process for as many parameters as you would like. 
 To delete a parameter, simply highlight it in the list and click the Delete button. 
 To move a given parameter within the list or change the order of the parameters, simply highlight the 

item in the list and click the Move Up or Move Down buttons. 
 

Step 3: Check the Use a free-form text box check box located in the Parameters 1 tab if you want a blank text box 
to appear during the calibration report.  The free-form text box allows the user to record additional 
calibration data or procedures in paragraph form. 

 

THREAD CALCULATOR 
The Thread Calculator is an important and useful feature in version 5.2 that allows you to have Calspex automatically 
determine thread dimensions based on a specific thread type.  For example, when you are calibrating a threaded 
plug, you can tell Calspex that the plug is a UN Class 2, 2.50” nominal diameter with a 10 pitch.  The Thread 
Calculator will then calculate ALL of the pertinent information.  The resulting calculations can be incorporated into the 
various parameters you have established.  Check the Use Thread Calculator check box if you are going to use these 
features in your Gage Type. 
 
Several different windows are used for this setup.  From the Parameters 1 tab use the Thread Gage button to bring 
up the following window: 
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       Figure 9: Thread Gage Type Window 

 
This window allows you to choose what type of gage you will be calibrating.  This setting affects the entire gage 
definition file. 
 
To assign thread dimensions to specific parameters, simply double click on the parameter in the list or click the Edit 
button.  The following window will appear: 
 

 
   
    Figure 10: Thread Parameter Setup Window 

 
Select either the GO Gage or the NOGO Gage radio button.  Then click the appropriate dimension you want to 
automatically appear in the selected parameter.  Click OK when you are finished.  Continue to use this Thread 
Parameter Setup for each parameter in your list. 
 



Calibration Control Software 5.2 
 

 

The Datasets Tab 
The Datasets tab enables you to define the kind of Datasets (numerical values) you wish to include for a particular 
Gage Type.  The Datasets tab looks similar to the Parameters 1 and Parameters 2 tabs and functions in much the 
same way. 
 

 
        
           Figure 11: Gage Definition Window (Datasets Tab) 

 
To establish Datasets: 
Step 1: Click on the Datasets tab. 

Step 2: Click the Add button.  Notice that the words NEW 
DATASET appear in the dialog box.  Continue 
clicking the Add button to include as many Datasets 
as you like. 

11

Step 3: To further define a particular Dataset, highlight it in 
the list and click on the Edit button, or simply double 
click on the desired Dataset.  Notice that you have 
retrieved the Dataset Properties window.  The 
Dataset Properties window consists of three tabs:  
 Properties tab  
 Defaults tab  
 Master Values tab 

 
Step 4: Click on the Properties tab, if it is not already 

displayed. 
 
Step 5: Give your Dataset a title by typing in the highlighted 

Dataset Title field. 
 
Step 6: Determine how the master values for this Gage 

Type are calculated by selecting an option from the 
master values radio button group: 
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 Prompt for begin/end…Selecting this option instructs Calspex to take the beginning master value and 
add it to each master value.  See Step 16 below for more information on using the begin/end option. 

 
             
 
            Figure 12: Dataset Properties Window 

 
 Prompt for begin/end/increment…Selecting this option instructs Calspex to calculate each master value 

starting with the Begin Master value and proceeding to the End Master value in the increment which 
you specify. 

 Prompt for all masters…Selecting this option instructs Calspex to prompt you for all master values at 
the time of calibration.  Use this option when the number of master values, or the master values 
themselves, change from one calibration to another. 

 Use a Specific Parameter n times…Selecting this option instructs Calspex to use the value of a 
parameter listed in the Parameters 1 tab and use it as a master value(s).  Notice that when you click on 
this option, a list of those parameters appears.  Simply double click on the desired one or highlight it in 
the list and click OK.  When prompted, enter the number of times you want the value repeated and click 
OK or press the Enter key.  

 Always use a specific set of masters…Selecting this option instructs Calspex to use the same master 
values for each gage of this type.  The user is not prompted for master value information while 
performing the calibration. 

 Duplicate another Dataset…Selecting this option instructs Calspex to duplicate master values from 
another Dataset.  Notice that when you click on this option, a list of Datasets appears.  Simply double 
click on the desired one or highlight it in the list and click OK or press the Enter key.  

 
The Properties tab determines the method by which Calspex calculates master values.  The Master 
Values tab allows you to enter the master values themselves. 
 

Step 7: Determine the type of information stored when multiple passes are used during a calibration.  
 Click the first radio button if you want Calspex to store the average of measurements taken during 

multiple passes.  
 Click on the second radio button if you want Calspex to store the maximum deviation of each 

measurement.  
 
Step 8: Check the Warn for out of tolerance on this Dataset check box if you want Calspex to display the gage’s 

tolerance status for this Dataset when you are prompted to pass or fail the gage. 
 
Step 9: Check the Prompt for this Dataset check box if the Dataset is optional and does not need to be used for 

each calibration. 
 
Step 10: Check the Store ID #’s for each data value check box if you want to display additional information for 

each measured value.  The most common use for this option would be if you have a gage block set and 
wish to include the individual serial numbers for each gage block.  Otherwise, this column could include 
brief notes or comments pertaining to each reading during calibration. 

 
Step 11: Check the Use-in line multiple passes check box if you want to have Calspex display the same set of 

master values more than once so that the user can enter additional measurements for each value. 
 
Step 12: Enter any uncertainty values in the Measurement Uncertainty text box.  These values will be displayed 

underneath each Dataset on both the calibration report and during the calibration process. 
 
Step 13: If applicable, check the Use an Offset check box if you want to be prompted for an offset value when 

completing a Dataset.  Offsets are constants that are added to the master values.  For instance, a NOGO 
gage pin set might have an offset of 0.0002”.  The nominal diameter for a 0.250” pin would therefore be 
0.2502”. 
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Step 14: Click on the Defaults tab.  
 
Step 15: Determine your default tolerances for this gage.  This is the amount of inaccuracy you are willing to 

tolerate while calibrating this type of gage.  
 If you choose to express tolerance in numerical values, click the appropriate radio button and tab to the 

+ Tol. and - Tol.  fields.  Enter the positive and negative deviations.   
 If you choose to express tolerance as a percentage, click on the % of Master radio button and tab to the 

% Tol. field.  Enter the tolerance percentage which will then be calculated automatically for each master 
value during the calibration process. 

 
Do not include the plus sign, (+) minus sign (-) or percentage sign (%) when entering the tolerance 
values. 
If certain options do not appear in the Defaults tab, it is likely because those options are not 
applicable to your specific type of Dataset. The options that appear here depend upon those 
selected earlier in the Properties tab. 

 
Step 16: If you are using the begin/end options for master 

values, more fields will appear below the Tolerances 
section.  Tab to the Begin Master, End Master, 
Increment, Master Range and Master Increment fields 
to enter the desired default values.  

 The Master Range field is used to specify the entire 
range of the master values you define for this gage. 
For example, if your master values go from 0.0000 to 
25.2000 your Master Range would be 25.2000. 

 When calibrating gages that exceed the master range, 
the software automatically increments the master 
values by a specific amount until the end value is 
reached. This increment amount is the Master 
Increment value.  For example, if our master values 
range from 0.0000 to 25.0000 and after 25.0000, we 
want to increment by 25.0000 units, we would enter a 
master range and a master increment of 25.0000.  
Using these values, a gage with a begin master of 
0.0000, and an end master of 100.0000 would have 
calibration points at 0.0000  25.0000 (according to 
our “Master Values”), then 50.0000, 75.0000, and 
100.0000.  

 
 
 
 
 

Figure 13: Dataset Master Values 
 
Step 17: Click on the Master Values tab. 
 

Depending upon the selections made in the Master Values section of the Properties tab, this screen 
may be blank.    
 

Step 18: Enter the first master value for the Dataset by clicking on the Add button and typing in the value. 
Continue pressing the Add button to enter as many values as you like.  
 To insert another master value in the list, simply highlight the number in the list beneath which you want 

to insert another value. By default, 0.000000 appears as the inserted value. To change the value, 
simply highlight it and enter a new number. 

 To delete a value, simply highlight it and click the Delete button. 
 To clear all master values already entered, click on the Clear button.  
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Step 19: You have now completed all the options in the Dataset tab. Click OK to save the preferences selected in 
the Dataset Properties window. 

 
The Comments Tab 
The Comments tab allows you to customize the comments that appear by default in the Comments window during a 
calibration report. 
 

 
 
Figure 14: Comments Tab 

 
To establish comments: 
Step 1: Click on the Comments tab. 
 
Step 2: Click the Add button. Notice that the word BLANK appears highlighted in the both the dialog box and the 

field below it. Simply type the desired comment directly over the highlighted text. Continue clicking the 
Add button to repeat the process for as many comments as you like.  
 To delete a comment, simply highlight it and click the Delete button. 
 To clear all comments already entered, click the Clear button.  
 To move a given comment within the list or to change the order of the comments, simply highlight the 

item in the list and click the Move Up and Move Down buttons. 
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The Repairs Tab 
The Repairs tab allows you to enter the text that appears by default in the Repairs window during a calibration report. 
 

 
 
Figure 15: Repairs Tab 

To establish repairs: 
Step 1: Click on the Repairs tab. 
 
Step 2: Click the Add button.  Notice that the word BLANK appears highlighted in the both the dialog box and the 

field below it.  Simply type the desired repair comment directly over the highlighted text.  Continue 
clicking the Add button to repeat the process for as many repair comments as you like.  
 To delete a repair, simply highlight it and click the Delete button. 
 To clear all repairs already entered, click the Clear button.  
 To move a given comment within the list—that is, to change the order of the comments—simply 

highlight the item in the list and click on the Move Up and Move Down buttons. 
 
The GRR Info Tab 
The GRR (or gage repeatability and reproducibility) tab allows you to instruct Calspex to report the amount of 
repeatability and human error when conducting a calibration report on a given Gage Type.    
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Figure 16: GRR Info Tab 

To establish Gage R&R information: 
Step 1: Click the Use Gage Repeatability & Reproducibility info check box if you want Calspex to report the 

amount of Gage R&R information each time this gage is calibrated. 
 
Step 2: Click the Use an Existing GRR Report for all gages radio button if you want Calspex to use an existing 

GR&R report each time this gage is calibrated.  Then specify the GR&R report filename in the Filename 
field, or browse for the desired filename by clicking the button displaying a folder. 

OR 
Step 3: Click on the Perform a new GRR on all gages radio button if you want to conduct gage repeatability and 

reproducibility during each calibration of the gage. 

 Remember to Save Your Gage Type! 
Once you have defined your gage to your satisfaction, using all the tabs available to you in the Gage Definition 
window, be sure to click the OK button to save your Gage Type. 
 
Label Setup Tab (Using Calibration Tags) 
The Calspex software can print gage tags (calibration labels, etc...) using the Brother P-Touch PC serial label printer.  
The tag information and format is set specific to each gage definition.  To setup this information, use the last tab in 
the Gage Definition window, which is labeled “Cal Tag”. 
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Figure 17: Label Setup Tab 

 
To setup Calibration Tags / Labels: 
Step 1: To enable printing cal tags for this Gage Type, check of the top check box.  
 
Step 2: Select the width of the tape you want to use for this type of gage using the various radio buttons. 
 
Step 3:  Select the length of the tape in the box, and select the proper font size to use (Normal, Small, or Micro). 
 
Step 4: Adjust the cal tag format using the large text box.  You may type any text you like in this box (like your 

company name, etc.)  To insert actual gage information, use the following codes: 
<CONTROL> Control Number 
<MFG> Manufacturer 
<MODEL> Model Number 
<SN> Gage Serial Number 
<LOCATION> Home Location 
<DEPT> Department for this gage 
<COMPANY> Owner of the Gage 
<CERTBY> Calibration Technician’s Name 
<DOCNO> Calibration Document Number 
<CALDATE> Calibration Date 
<DUEDATE> Next Calibration Due Date 
<FILENAME> Filename of the Calibration Report. 
<CALBOX> Prints the word ‘Calibration’ inside a box. 
 

When inserting gage fields, be sure that the brackets (“<” and “>”) have at least one space before 
and after them, unless when a field is the first thing on a new line. 
 

Step 5: Test the tag format by using the printer button located at the top of the window.  Make sure you select the 
correct printer when the print dialog box appears. 

 
Other Gage Type Options 
Editing a Gage Definition File: 
Step 1: Click Gage Types in the main menu and select the Edit option.   
 
Step 2: When prompted with a list of all Gage Types, select the one you wish to edit from the list.  Notice you 

have retrieved the Gage Definition window. 
 
Deleting a Gage Definition File: 
Step 1: Click Gage Types in the main menu and select the Delete option.   
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Step 2: When prompted with a list of all Gage Types, select the one you wish to delete from the list.  When 

prompted, click Yes. 
 
Importing a Gage Type: 
Step 1: Instruct Calspex where to find the .gdf files by clicking Gage Types in the main menu and select Import 

Gage Types. 
 
Step 2: Select the desired files to import and click OK or press the Enter key.  The imported files are now 

available for use.  You may now select your newly imported Gage Type(s) from the Select Gage Type 
List. 

 
Holding down the Shift key and clicking on the first and last file allows you to select all files in the 
list.  Holding down the Control key allows you to multi-select individual files in the list. 
 

Using the Gage Type Wizards: 
Step 1: Click Edit in the main menu and select either New Gage Type Wizard or Edit Gage Type Wizard. 
 
Step 2: If you are creating a new Gage Type, enter the title and click OK or press the Enter key. 
 
Step 3: If you are editing an existing Gage Type, select it from the Select Gage Type List. 
 
Step 4: Click the Next and Prev buttons to navigate through the wizard.  Follow the on-screen instructions to 

continue.  Once the end has been reached, click the Finish button to close and SAVE your Gage Type.  If 
you click Cancel before reaching the end, your changes will not be saved. 
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Customer Database 
Calspex comes complete with a company “rolodex,” ideal for calibration houses with many customers.  This 
customer database can be accessed during a calibration report, thereby allowing you to enter company information 
with the click of a button.  You will notice that initially most of the fields in the Customer Database are grayed.  This 
new feature has been implemented to avoid accidentally making changes or deleting customer records.  Simply click 
the Edit Mode button to switch to the editing mode.  Now you can add, delete or make any other changes you 
require.  By clicking the View Mode button, the Customer Database will once again be secured.  The only two fields 
that can be changed in any mode are Department and PO/Acct. 
 

 
 
Figure 18: Customer Database Window 

Editing the Database 
Add Customers: 
Step 1: Access the Customer Database by clicking Tools in the main menu and selecting Customer Database.  

Notice you have retrieved the Customer Database window. 
 

The customer database cannot store multiple records with the same company name.  To avoid this 
situation, use abbreviations, or alter punctuation in the company name. 
 

Step 2: Click the Edit Mode button to have full access to the Customer Database window and all the fields. 
 
Step 3: Click inside the Company field and enter the company name. 
 
Step 4: Tab to the remaining fields and enter the company’s address and administrative information.  
 
Step 5: Once you are finished entering the information, click the Save button (check mark) to save changes to 

the Customer Database. 
 
Delete Customers: 
Step 1: Find the desired company by one of the following methods: 

 Use the arrow buttons provided to search through all customer records. 
 Click the Find Customer button and enter the company name when prompted.  Click OK or press the 

Enter key. 
  

Step 2: Click the Edit Mode button to have full access to the Customer Database window and all the fields. 
 
Step 3: Once you have retrieved the desired customer, simply click the minus (-) button in the button bar.  When 

prompted, click OK or press the Enter key. 
 
Update Customer Records: 
Step 1: Find the desired company by one of the following methods: 
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 Use the arrow buttons provided to search through all customer records. 
 Click the Find Co. button and enter the company name when prompted.  Click OK or press the Enter 

key. 
 
Step 2: Click the Edit Mode button to have full access to the Customer Database window and all the fields. 
 
Step 3: Once you have retrieved the desired company record, simply click inside the fields and alter the 

information as you like. 
 
Step 4: Click the check mark button in the button bar to save the changes. 
 

If you work in a multi-user environment, where records are changing rapidly, you can update the 
information on your screen by clicking the Refresh button.  This button can only be accessed in the 
edit mode.  
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Preferences 
Customize Calspex even further by creating your own defaults and ensuring that your personal preferences are 
retained and given priority whenever you use the program.  Once you select a preference for a certain feature, your 
preference becomes the default. 
 
To open preferences: 
Step 1: Click on this button in the toolbar,  or click Edit in the main menu and select Preferences.  
 
Step 2: Enter your password when prompted. 
 

If you have not previously customized Calspex, use the default password, “ads”, until you are able 
to select your own.  Please see the Preferences Tab section below for more information about 
passwords. 
 

Notice that you have retrieved the Calspex Preferences window.  This window has eight tabs at the top. 
 

 
 
Figure 19: Calspex Preferences 

The Preferences Tab 
The Preferences tab in the Calspex Preferences window allows you to specify where Calspex saves calibration 
reports, Gage Types (Gage Definition Files), and internal tables.  Here you can also establish the link, if any, 
between Calspex and the Recall Database.  
 
Please be aware that these settings are automatically established during the installation process.  Any changes to 
this setup following the installation might cause Calspex to not function as intended.  Only edit this information if you 
are familiar with your computer or network setup and have contacted Vantek support if you are unsure. 
 
To establish preferences: 
Step 1: Click on the Preferences tab, if it is not already displayed. 
 
Step 2: Click inside the Default Data Path field.  Enter the data path you want Calspex to use when saving and 

loading calibration reports.  If you are not sure which data path to use, click the Browse button and select 
one from the Path Dialog window. 
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Step 3: Determine the number of documents you can have open at one time by clicking on the Close Action drop-
down box.  
 Close on Open/New…Clicking on this option allows you to have only one document open at a given 

time.  Open documents will be closed when you start a new report or open an existing report. 
 Close on Save…Clicking on this option causes a document to be closed once you save it.  Calibration 

reports will be closed when each report is saved. 
 Never Close Automatically…Clicking on this option instructs Calspex never to close a document unless 

you close it yourself. 
Step 4: Tab to the Extra Database Path field.  Enter the database path you want Calspex to use when saving and 

loading internal tables.  Internal tables store gage manufacturer and model information, NIST numbers, 
and company information.  If you are not sure which database path to use, click the Browse button and 
select one from the Path Dialog window. 

 
Step 5: Tab to the Gage Types Path field.  Enter the file path you want Calspex to use when saving and loading 

Gage Types (Gage Definition Files).  If you are not sure which path to use, click the Browse button and 
select one from the Path Dialog window.  

 
Step 6: Determine the type of link between Calspex and the Recall Database by clicking on the Recall Action 

drop-down box. 
 No Database Link…Clicking this option severs all connections between Calspex and the Recall 

Database.  (This option is provided for those who use Calspex but not the Recall Database).  
 Update New Reports…Clicking on this option ensures that new reports created in Calspex are saved in 

the Recall Database.  
  

Those reports that are updated in Calspex, however, are not updated in the Recall database. 
 

 Update all Reports…Clicking on this option ensures that all reports created, updated, or edited in 
Calspex are updated and saved in the Recall Database. 

  
Step 7: Tab to the Recall DB Path field.  Enter the data path where Calspex can find the Recall Database.  If you 

are not sure which path to use, click the Browse button and select one from the Path Dialog window.  
 
Step 8: Determine the next document number to be assigned to a calibration report.  Simply enter the number 

manually in the Next Document # field, or use the arrow buttons to increase or decrease the number. 
 
Step 9: In the Next Cal Date Increment field, determine the default time increment between calibration reports.  

The number displayed here refers to days.  Simply use the arrow buttons to increase or decrease the 
time increment, or type your own within the field itself. 

 
The time increment specified here enables Calspex to calculate the next calibration dates for each 
report you perform.     
 
The following step should be performed only if you have deleted your databases and wish to create 
new ones. 
 

The following steps are optional: 
 

Step 10: Click on the Create New Tables button if your databases have been deleted, or if you need to create 
multiple databases. 

 
Step 11: Edit your password by clicking on the Change Password button.  Enter the desired password twice when 

prompted and click OK or press the Enter key.  
 
Step 12: If you wish to erase all old document numbers and begin fresh, click the Clear Old Doc #s button. 
 
Step 13: If you plan on having a large database (thousands of records or more), you can check the “Use 

Subdirectories of 1000 files in Data directory” check box.  Once this option is enabled, any new 
calibration reports will be saved to its corresponding subdirectory according to its document number.  
These individual folders will be located in the Calspex Data folder (CCS5\Data).   
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 Certificate# 2438 would be placed in the 2k folder.  (CCS5\Data\2k) 
 Certificate# 8100 would be placed in the 8k folder (CCS5\Data\8k) 
 Certificate# 17501 would be placed in the 17k folder (CCS5\Data\17k) 

 
Please note that once you select this option, it will only begin to separate certificates from the time 
you checked it.  It will not separate existing certs already located in the Data folder. 

The Options Tab 
The Options tab allows you to set up certain startup, printing, and calibration report features. 
 

 
 
Figure 20: Options Tab 

 
To establish startup, printing, and calibration report features: 
Step 1: Click the Options tab. 
 
Step 2: Choose which programs, if any, you would like to have opened each time you use Calspex.  Simply 

check the desired programs in the Startup Option check box group. 
 
Step 3: Determine which features you would like activated during the calibration report process by choosing from 

the options displayed in the Calibration Options check box group.  
 

 Use warnings…This option causes Calspex to warn you during a calibration report if you have not 
entered a control number or if you have not filled in the “Certificate by” field. 

 Put focus on ‘Next’…This option causes the Next button to be emphasized during the calibration report 
process.  Essentially, the Next button becomes the default button, allowing you to simply press the 
Enter key to advance to the next screen. 

 Put cursor on ‘Next’…This option instructs Calspex to place the mouse cursor on the Next button 
throughout the calibration report process. 
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 Always show procedures…This option instructs Calspex to always display the Calibration Procedure for 
a given Gage Types when creating a calibration report.  The procedure will be displayed at the bottom 
of the screen during the calibration report process.  See “Creating/Editing Gage Types” for more 
information about entering a Calibration Procedure for a Gage Type. 

 Use flat toolbar buttons…By selecting this option, Calspex will display the toolbar icons flat instead of 
raised. 

 Maximize calibration window…This option instructs Calspex to maximize the calibration window when 
creating or editing a calibration report.  It will automatically be maximized. 

 Use 9 decimal places…This option will allow Calspex to display 9 decimal places as opposed to the 
default value of 6. 

 
Step 4: Determine how Calspex interprets in or out of tolerance conditions. 

 Click the Greater than tolerance radio button if you want Calspex to declare a gage out of tolerance 
when the deviation is greater than the maximum deviation specified. 

 Click the Greater/Equal to tolerance radio button if you want Calspex to declare a gage out of tolerance 
when the deviation is greater than or equal to the maximum deviation specified.  

 
Step 5: Determine the format and contents of your printed calibration report by selecting certain options from the 

Print Options group. 
 Print GRR Reports…Clicking this check box causes the Gage R&R value, calculated for a particular 

gage, to be printed after the calibration report. 
 Print Gage Tags…Clicking this option instructs Calspex to print Gage Tags after completing a 

calibration report. 
 Print Short Form…Click this option if you want only the gage information, not the numerical data, 

displayed on a printed report.  
 Print Long Form…Click this option if you want both the gages information and all the accompanying 

numerical data displayed on a printed report. 
 Always print in black…Use this option for printers that do not correctly print out of tolerance 

measurements.  These entries usually print in red ink. 
 Print Next Cal Date on failed reports…Selecting this check box will instruct Calspex to always print the 

next calibration date (due date) on all calibration reports, even the gages that have failed.  Otherwise, if 
this option is not enabled, Calspex will NOT print the next calibration date on reports in which the gage 
has failed. 

 Print Procedure…Clicking this check box instructs Calspex to print the entire Calibration Procedure 
from a given Gage Type.  The procedure will be taken directly from the Gage Type that was used to 
create the calibration report. 

 
Step 6: Setup Calspex with your gage locations by clicking on the Edit Location List button.  Notice the Location 

List window appears.  Simply type each gage location on a separate line within the text box.  Then click 
OK or press the Enter key. 

 
Calspex makes the location list available to you in the Location drop-down box of a calibration report 
(Gage Info screen), thereby saving you the time of entering the location manually.   
 

Step 7: Setup Calspex with your list of employees that are able to certify gages by clicking on the Edit Employee 
List button.  Notice that the Employee List window appears.  Simply type each employee name (or other 
form of identification) on a separate line within the text box.  Then click OK or press the Enter key. 

 
Calspex makes the employee list available to you in the Certificate by drop-down box of a 
calibration report (Header Info screen), thereby saving you the time of entering the employee name 
manually. 
 

Step 8: Setup Calspex with your desired list of default parameters which will appear in the Parameters 1 section 
for each calibration report you create.  These parameters will be text only and cannot be used to define 
any tolerances, datasets, etc.  Parameters already setup in the Gage Types will still appear along with 
the global ones. 

 
Step 9: Setup Calspex with your desired list of default global comments which will appear in the Comments 

section for each calibration report you create.  Comments already setup in the Gage Types will still 
appear along with the global ones. 
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The Field Names Tab 
The Field Names tab allows you to edit and change field names as they would appear in Calspex AND on calibration 
reports.  Calspex comes installed with default values that can be modified at anytime.   
 

 
 

Figure 21: Field Names Tab 
The Letterhead Tab 
The Letterhead tab allows you to change the appearance of your company name and address, which is printed at 
the top of each certificate.  Here you can adjust the font style, font size or add any additional information.  If the Print 
Letterhead and select company info for each gage check box is checked, you will have the option of selecting 
different customers from the Customer Database when you create a new calibration report.  Otherwise, your 
company name will always be displayed by default in the Header Information section. 
 

 
 

Figure 22: Letterhead Tab 
The Company Info Tab 
The Company Info tab contains information pertaining to your particular company and other vendors.  If the “Print 
Letterhead…” check box is selected in the Letterhead tab, you will be able to select a vendor at the beginning of the 
calibration report (Header Info).  This vendor information is printed at the top of every calibration report, above the 
customer name and address.  This is a valuable feature for calibration houses that occasionally use outside vendors 
to calibrate their customer’s equipment.  If you do not wish to use vendor files, this tab does not apply. 
 

Much of the information entered here is displayed in the header of a printed calibration report. 
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Figure 23: Company Info Tab 

 
To add a new vendor: 
Step 1: If you wish to add a new vendor to the drop-down box simply click the New Vendor button. 
 
Step 2: You will notice that the only field displayed is the Vendor Name.  Type the name of this new vendor file 

and press the Enter key. 
 
Step 3: The address fields will now appear.  Simply type over the information with the correct company name, 

address and disclaimer for this new vendor.  Click the OK button to save any changes. 
 
To delete a vendor: 
Step 1: If you wish to delete a vendor simply select that vendor from the drop-down box and click the Delete 

Vendor button. 
 
To import a vendor: 
Step 1: If you wish to import a vendor simply click the Import Vendor button. 
 
Step 2: Select the correct .vnd file and click Save. 
 
Step 3: You will notice that the only field displayed is the Vendor Name.  Type the name of this new vendor file 

and press the Enter key.  All the information from the vendor file will be automatically displayed in the 
appropriate fields. 

 
To edit company information without using a vendor file: 
Step 1: Make sure that the <Do not use vendor file> option is selected in the Vendor Name drop-down box.  If 

you need to change your company information you can do so simply by editing the appropriate fields.    
  
To edit company information when using vendor files: 
Step 1: Make sure that the correct vendor is selected from the Vendor Name drop-down box.  If you need the 

company information you can do so simply by editing the appropriate fields. 
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The Mfg & Models Tab 
The Mfg & Models tab allows you to record the gage manufacturers and models your company deals with on a 
regular basis.  The information entered here is then made available to you during a calibration report, with the simple 
click of a button, thereby saving you the time of entering the information manually.   
 

 
 
Figure 24: Mfg & Models Tab 

 
The Mfg & Models tab contains two lists:  One for manufacturers and one for models.  These two lists are cross-
referenced, enabling you to assign several different models to each manufacturer. 
 
To add gage manufactures and models: 
Step 1: Click the plus (+) sign under the Manufacturers heading.  Notice that Calspex has provided you with a 

blank space in the Manufacturers list. 
 
Step 2: Type the name of the new manufacturer and click the Manufacturer’s check mark button.   
 
Step 3: Add the gage models made by this particular manufacturer by highlighting the new manufacturer in the 

Manufacturers list and clicking the plus (+) button under the Models heading.  Notice that Calspex has 
provided you with a blank space in the Models list.   

 
Step 4: Click inside the highlighted space in the Models list and begin type the name of the model.  Then click the 

Models check mark button.    
 
Step 5: Repeat Steps 4 and 5 for as many models as you like. 
 

You can determine where in the list your new manufacturer or model appears by clicking on the row 
just beneath the desired location.   
 



Calibration Control Software 5.2 
 

 29

The NIST Info Tab 
The NIST Info tab maintains a list of all your calibration masters traceable to NIST.  Calibration masters are recorded 
here, in order to make them available to you during calibration reports.  The NIST Numbers tab also allows you to 
create master sets.  Master sets combine several master gages used during a calibration into a single entry.   

 
 
Figure 25: NIST Numbers Tab 

To add master gages: 
Step 1: Click the plus (+) button in the button bar at the top of the tab.  Notice your cursor is blinking inside the 

Control # field. 
 
Step 2: Type the master gage’s control number in the Control # field. 
 
Step 3: Tab to the Description field and enter a description of the master gage. 
 
Step 4: Tab to the NIST # field and enter the gages NIST number. 
 
Step 5: Tab to the Last/Next Cal fields and enter the master gage’s last and next calibration dates.  
 
Step 6: Click the check mark button in the button bar to add the new master gage. 
 

Once the Control # for a master gage is entered into the NIST database, any new calibration report 
created in Calspex for that particular master will automatically update the NIST database with the 
latest NIST# and Last/Next Cal fields. 

 
To edit master gages: 
Step 1: Find the desired master gage by using one of the following methods: 

 Use the arrow buttons provided to search through all master gage records. 
 Use the ninth button in the toolbar to retrieve a condensed list of all master gages.  Simply select the 

desired one from the list and click OK. 
 Click the tenth button in the toolbar, enter the control number of the desired master gage, and click OK 

or press the Enter key.  
 
Step 2: Once you have retrieved the desired master gage, simply click inside the fields and change the 

information as you like.  Remember that this information is automatically updated when a master gage is 
calibrated in Calspex. 
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Step 3: Click the check mark button in the button bar to save any changes. 
 
To delete master gages: 
Step 1: Find the desired master gage by one of the following methods: 

 Use the arrow buttons provided to search through all master gage records. 
 Use the ninth button in the toolbar to retrieve a condensed list of all master gages.  Simply select the 

desired one from the list and click OK or press the Enter key.  
 Click the tenth button in the toolbar, enter the control number of the desired master gage, and click OK 

or press the Enter key. 
 
Step 2: Once you have retrieved the desired master gage, simply the minus (-) button in the button bar.   
 
To define master gage sets: 
Step 1: Click the New Set button in the bottom left corner of the tab.  When prompted, enter a name for the 

master gage set and click OK or press the Enter key.  
 
Step 2: Find the master gages you wish to be part of this master set by one of the following methods:  

 Use the arrow buttons provided to search through all master gage records. 
 Use the ninth button in the toolbar to retrieve a condensed list of all master gages.  Simply select the 

desired one from the list and click OK or press the Enter key.   
 Click the tenth button in the toolbar, enter the control number of the desired master gage, and click OK 

or press the Enter key.  
 
Step 3: Click the Add Gage button to add this gage to the master set. 
 
Step 4: Repeat Steps 2 and 3 for the gages you want to comprise the master gage set. 
 

To delete a master gage set or a master gage from either list, simply highlight it and click the Delete 
Set button or the Delete Gage button. 
 

The Printers Tab 
The Printers tab has a drop-down box which contains a list of your printers currently being used on your computer.  
If you are using a Label Printer, simply select it from the drop-down box.  This will be used as the default printer for 
Calspex. 
 

 Remember to Save Your Preferences!  
Once you have customized Calspex to your satisfaction, using all the tabs available to you in the Calspex 
Preferences window, be sure to click OK or press the Enter key to save your preferences. 
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Calibration Reports (Certificates) 
Having defined your gages and customized Calspex, the calibration report process is easy.  Simply complete the 
steps as Calspex prompts you.  At the end, you are left with an accurate and professional calibration report.  
 
Each calibration report is catered specifically to the particular Gage Type, as specified by the gage definitions you 
created earlier.  The features of calibration reports, therefore, vary greatly from gage to gage and are controlled, 
largely, by you. 
 
A generic calibration procedure is outlined below.  Keep in mind, however, that this description is skeletal— that, 
depending upon your Gage Type, your calibration report may contain additional features.          
 
Creating a New Report 
To begin a new calibration report, click the first button in the toolbar, or click File in the main menu and select 
New. 
 
1. Select Gage Type 
What type of gage do you want to calibrate?  This is the first thing Calspex needs to know before guiding you through 
a new calibration report.  
 

You can change your Gage Type at any time in the calibration process.  Simply click Edit in the 
main menu and select Change Gage Type.  Then choose the desired type from the Select Gage 
Type List. 
 

 
Figure 26: Pick List 
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To select a Gage Type: 
Step 1: Simply select the desired Gage Type from the Select Gage Type List and click OK or press the Enter key. 
  

The gages available to you in the Select Gage Type List are those you have created yourself during 
gage definition, as well as certain generic Gage Types provided by Calspex. 
 

2. Enter the Header Information 
The header contains information about the company for which you are calibrating the gage.  In the case of a 
calibration house, the header displays their vendor file and customer information.  In the case of the end-user, 
however, the header displays information about his or her own company.  You may click the Next and Prev buttons 
at anytime throughout the calibration report process in order to navigate through the different sections. 

 

 
         
         Figure 27: Header Information 

 
Any written calibration procedure specified in the Gage Type will appear 
here. 

 
To enter header information for the calibration house: 
 

Ensure the “Print Letterhead…” check box in the Letterhead tab of Calspex Preferences is checked.  
When this box is checked, the company information in the header is changeable for each calibration 
report.  For more information, please refer to the section entitled, The Letterhead Tab. 
 

Step 1: Select a vendor for this particular gage by clicking the Vendor drop-down arrow.  This can either be your 
own company or another vendor depending on what you established in the Company Info tab of Calspex 
preferences. 

 
Step 2: Select the customer for whom you are calibrating the gage (if different from the one already displayed) by 

clicking the Select Customer button.  Notice that you have retrieved the Customer Database window. 
 
Step 3: Use one of the following methods to find the desired company record:  

 Use the arrow buttons to search through the company records  
 Click on the Find Customer button and enter the name of the desired company in the dialog box 

provided.  Calspex then jumps directly to that company’s record. 
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Step 4: Click the Customer Database window’s OK button when you have retrieved the desired company record.  
Notice that the company information has been inserted into the header for you. 

 
Step 5: Add or modify the information displayed by clicking in the fields and typing in the desired information. 
 
Step 6: Tab to the Cal Date field and enter the calibration date if different from the one displayed.  Calspex 

automatically enters the current date for you. 
 
Step 7: Tab to the Certificate by field and enter the name of the person certifying the gage, or select one from the 

drop-down list. 
 
Step 8: Once the header information has been added, click the Next button. 
  
To enter header information for the end-user: 
 

Ensure the Print Letter Head check box in the Company tab of Calspex preferences is NOT 
checked.  This is the best option for the end-user.  When this box remains unchecked, the company 
information appears grayed out and unchangeable in the header.  For more information, please 
refer to the section entitled, The Letterhead Tab. 
 

Step 1: Tab to the Contact field and enter the name and/or telephone number of the person to contact regarding 
this gage. 

 
Step 2: Tab to the Department field and enter the department to which the gage belongs. 
 
Step 3: Tab to the PO/Acct field and enter a purchase order or account number. 
 
Step 4: Tab to the Cal Date field and enter the calibration date if different from the one displayed.  Calspex 

automatically enters the current date for you. 
 
Step 5: Tab to the Certificate by field and enter the name of the person certifying the gage, or select one from the 

drop-down list. 
 
Step 6: Once the header information has been added, click on the Next button. 
 
3. Enter the Gage Information 
After entering company/vendor information in the header, Calspex prompts you for specific information about the 
current gage being calibrated. 
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Figure 28: Gage Info Window 
To enter gage information: 
Step 1: Click inside the Control # field of the Gage Info window and enter the gage’s control number. 
 
Step 2: Tab to the Manufacturer field and enter the gage’s manufacturer, or select one from the drop-down list. 
 
Step 3: Tab to the Model field and enter the gage’s model, or select one from the drop-down list. 
 

The manufacturers and models available to you here are determined by those entered in Calspex 
Preferences.  Please refer to the section The Mfg & Models Tab for more information. 
 

Step 4: Tab to the Serial # field and enter the gage’s serial number. 
 
Step 5: Though Calspex might enter the name of the gage in the Gage Desc field (if specified as a default during 

gage definition), you can tab to this field and modify the description as you like.  
 
Step 6: Tab to the Location field and enter the gage’s location, or select one from the drop-down list.  
  
Step 7: After entering all pertinent gage information, click the Next button. 
 
4. Enter the Parameters 
Parameters may or may not be used in different Gage Types.  These fields are used to record and report information 
that is either numerical data, regular text, or is information which master values (for other datasets) is based on.  For 
example, on a Threaded Plug Gage Type, we might have the following window: 
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Figure 29: Parameters Window  

 
These parameters will be used for the calculation of their corresponding datasets.  To enter the parameters, simply 
type in the applicable information in the given fields. 
 
Using the Thread Calculator 
Some Gage Types will use the Thread Calculator to determine thread dimensions (like those shown above).  If this 
option is enabled, two additional windows will appear before the parameters screen is displayed. 
 
The first window allows the user to specify the thread characteristics.  Select the thread form, nominal diameter, 
thread pitch, class, tolerances (if applicable) and Length of Engagement. 

        
 

Figure 30: Thread Calculator Information 
 



Vantek 

 36 

Once you have entered the thread characteristics, the software will calculate standard dimensions and display the 
following window: 

 
 

Figure 31: Thread Calculations 
 
From this window, you can adjust these dimensions if the thread is a non-standard size.  Simply type in the new 
value, and click the appropriate Re-Calculate button. 
 
If the wires used are different from the best fit wire size displayed, simply select the new wire size from the list, or 
type in a custom wire size and click the Re-Calculate button. 
 
Once the proper values are shown, click the Next button.  You will see the normal Parameter set screen, but with all 
the thread dimensions filled in.  Click the Next button, or fill in any additional parameters. 
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5. Enter the Data 
Most calibration reports require the input of numerical values.  Calspex makes this process simple by incorporating 
the use of Datasets into the calibration report.  Each Dataset is broken-up into three primary sections: 
 

 Tolerances 
 Entering Master Values 
 Measured Values 

 
Depending on the Gage Type’s Dataset prompt option, Calspex will either display all Datasets at once or individually 
as you go through the calibration report process. 
 

 If the Gage Type instructs Calspex to display all Datasets at once, then a Dataset Selection screen 
will appear immediately after the Gage Info screen.  If there are many Datasets used in your Gage 
Type, feel free to use the Check All or Check None buttons.  Check which Datasets you wish to use 
in your calibration report and click the Next button.  Only those Datasets that have the “Prompt for 
this Dataset” checked in the Dataset Properties will be displayed in the Dataset Selection screen. 

 
If prompted for all at once, you can always go back and add or delete Datasets even after the 
calibration report is saved.  You cannot do this when the Datasets are displayed individually. 

 
 If the Gage Type instructs Calspex to display all Datasets individually, you will not have a Dataset 

selection screen, rather an information message pop-up asking you whether or not you wish to 
include a particular Dataset in your report.  When this happens, click Yes or No to advance.  
However if you click No, you may not access that Dataset again.  Only those Datasets that have the 
“Prompt for this Dataset” checked in the Dataset Properties will use the information message pop-
up. 

 
You must complete the measurements for each Dataset before moving on to the next one. 

 
When you recalibrate a gage, only those Datasets that were used in the LAST calibration of that 
gage will be selected.  You may still add or take away any Dataset according to your specifications 
(See Recalibrating a Gage).  Any Datasets that were used for the last calibration report, but do not 
exist in the current Gage Type will be displayed at the bottom of the Dataset selection window. 
 

Depending on the Gage Type setup, the next window is the tolerance window.  You may edit tolerances here. 
 
Because you have already established master values during gage definition (or earlier in the calibration report), you 
are only required to enter measured values here.  Calspex does the rest.  If, however, you want to enter other master 
values than those displayed, Calspex gives you the flexibility of doing so. 
 



Vantek 

 38 

 
 
Figure 32: Data Table 

 
Any uncertainty values entered for this Dataset in the Gage Type will appear here. 
 
What is the Data Table showing me? 
The data table consists of four vertical columns: 

 The first column displays the master values 
 The second column displays the measured or actual values 
 The third column displays the deviation of the measured values from the master values 
 The fourth column enables you to see, at a glance whether the gage is in or out of tolerance.  A green 

box means the measured value is in tolerance with the master value.  A red box means the measured 
value is out of tolerance with the master value. 

 The fifth column (if needed) enables you to enter an individual serial number or other information for 
each master value. 

 
To enter additional master values: 
Step 1: Click the Add Master button. 
 
Step 2: When prompted, enter the new master value and click OK or press the Enter key.  Notice that it appears 

immediately in the data table.  
 

You can enter new master values at any point in the data entry process. 
 
To add measured values: 
Step 1: Click inside the Measured Value field and enter your first measured value.  (If your measured value is the 

same as the master value, simply proceed to Step 2.) 
 
Step 2: Click the Add Value button.  Notice that Calspex proceeds immediately to the next value.  If you wish to 

remove the value just entered, click the Remove Value button. 
 
Step 3: Repeat Steps 1 and 2 for all measured values.   
 

If you want to skip a value at any point in the data entry process, simply click the Skip Value button. 
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To edit measured values: 
Step 1: You can change a measured value simply by clicking it in the data table, editing the value displayed in 

the Measured Value field, and clicking the Edit Value button. 
 

Once you have completed data entry, the Add Value button becomes the Edit Value button; both 
function the same way. 
 

To delete measured values: 
Step 1: You can delete a master value by selecting it in the data table and clicking the Delete Master button. 
 
Using the Data Table in Conjunction with another Program 
You may notice that if you right-click in the gray area of the data table, you retrieve a pop-up menu.  This menu is 
designed to help you use the data table in conjunction with other programs.   
 

 
 

Figure 33: Data Table Options  
 

From here you can perform the following: 
 Add a master value (functions the same way as the Add Master button) 
 Clear the Data table 
 Close the Data table 
 Re-establish a link with RS-232. 
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6. Enter NIST Information 
This portion of the calibration report enables you to specify the calibration master, traceable to NIST, used to 
calibrate your gage.  Because you have already established your master gages and master gage sets in Calspex 
preferences, there is no need to do so here.  Please refer to the section The NIST Numbers Tab for more information 
about setting up master gages. 

 
     
Figure 34: Next Cal, NIST Window 

 
To enter NIST and next calibration date information: 
Step 1: Select the type of calibration interval you want to use for this gage.  
 
Step 2: Specify the date or interval upon which you want to conduct the next calibration report, if different from 

the one displayed.  (Calspex automatically calculates this date from the time increment specified in the 
Preferences tab.  For more information, please refer to the section entitled The Preferences Tab.)  

 If you are using time based recalibration intervals, you can specify the Next Calibration Due date in 2 
ways: 

 Enter the date manually in the Next Cal Date field 
 Click on the small button displaying a 12.  When the calendar appears, use the arrow buttons to 

search through the months.  Then click on the desired date.   
If you are using usage based recalibration intervals, specify either the number of parts to be measured 
until the next calibration, or the number of usage hours. 
 

Step 3: If you are using a single master gage, ensure that the Single Master Gage radio button is clicked.  Then 
search for the desired master gage using one of the following methods: 
 Use the arrow buttons provided to search through all master gage records. 
 Click the Find Master button, enter the control number of the desired master gage, and click OK or 

press the Enter key.  
  

Step 4: If you are using a master gage set, ensure that the Master Gage Set radio button is clicked.  Then select 
the desired set from the drop-down list provided. 
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You can edit master gage sets simply by clicking on the Edit Sets.... button.  Notice that you have 
retrieved the NIST Numbers tab in Preferences.  For information on creating master gage sets, 
please refer to the section entitled The NIST Numbers Tab.   

7.  Comments/Text 
All calibration reports have a Comments section.  Default comments will be displayed here according to the 
specifications you used when setting up the Gage Type or any global comments.  Please be aware that even though 
you might have default comments, you can still delete or edit them.  To add additional comments simply begin typing 
anywhere in the text area.  If your Gage Type uses a Free-Form Text Box, a separate text area will appear 
immediately after the NIST Information.  This is basically the same as the Comments section however some people 
might prefer to manually type additional calibration data here. 
 
8.  Gage Status (Pass, Fail, Limited, As Found) 
All calibration reports require you to give a Pass/Fail gage status.  Regardless of whether gage readings are within 
the specified tolerance, or if you’ve taken numerical readings at all, it is entirely up to you whether or not you deem 
the gage to have passed, failed, limited calibration or readings as found. 
 

The Pass/Fail status of the gage is displayed on a printed calibration report.   
 

Calspex presents you with the following window.   
 

 
      
       Figure 35: Pass/Fail Window 

 
Notice that the Pass/Fail window shows you whether each Dataset has passed or failed within the specified 
tolerance.  This can be helpful when determining what Pass/Fail gage status to give.  Simply click the desired radio 
button; then click Next.   
 
9.  Save the Calibration Report 
After each calibration report, you are prompted to save it.  Unless you specify otherwise, each calibration report is 
saved under its document number.   
 
To manually save a report: 
Step 1: Click the third button in the toolbar,  or click File in the main menu and select Save or Save As. 
 
Step 2: When prompted, give the file a name.  Then click OK or press the Enter key.  
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Editing Calibration Reports 
Once you have completed a calibration report, there are several ways to retrieve it.  Choose one of the following 
methods: 

 Click the second button in the toolbar , or select File in the main menu and click the Open option.  
When the Open window appears, select the desired calibration report from the list of files and click OK 
or press the Enter key.  

 If you have recently completed the report, you may be able to retrieve it from the File menu itself.  The 
File menu displays the last five documents worked on.  Simply click the desired document from the list. 

 
Notice that, once you’ve retrieved a calibration report, the report flowchart appears.  The flowchart 
visually represents the features of the given report.  To view a particular portion of the report, simply 
click the corresponding heading in the flowchart.  
 

Recalibrating a Gage 
Calspex makes recalibrating a gage easy.  Simply follow the procedures outlined below. 
 
To recalibrate a gage: 
Step 1: Click Tools in the main menu and select Recalibrate a Gage.  Notice you have retrieved the Recalibrate a 

Gage window.   

 
 
Figure 36: Gage Recall Window 

 
Step 2: Find the gage you want to recalibrate using one of the following methods: 

 Type the gage control number in the Control # field.  Then click the Find button.  
 Scroll through the gages until you find the one you want to re-calibrate.  Highlight the gage in the list. 

 
Step 3: Click OK or press the Enter key.  Calspex launches you directly into the calibration process.  Notice that 

you do not need to enter gage and company information, as it is already entered for you.  The master 
values will be the same as well, as long as you select the same Dataset(s) as before. 
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Duplicating a Calibration 
The Duplicate Last Calibration option allows you to create new reports and reproduce the exact same data with little 
effort.  This feature saves time and eliminates the need to re-enter important information.  After you save a new 
calibration report, you can use this feature to duplicate data in your next report such as manufacturer, model, 
location, department, master values, comments, repairs, etc.  You will still have the ability to change measured 
values (if they are different from the previous calibration).  Calspex automatically uses the same Gage Type and it 
will even select the same datasets as before! 
 

Please note that even though the information is replicated, you can still make changes to any part of 
the certificate.  Once again, the data is not set in stone! 

 
To duplicate a last cal: 
Step 1: Click Tools in the main menu and select Duplicate Last Calibration.  A new calibration report will be 

displayed automatically.    
 
 
Step 2: Click the Next button throughout the entire certificate and you will notice that the data and master values 

are identical to your previous calibration. 
 
Step 3: Once you are finished, click the save button as usual. 
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Gage R&R 
To account for repeatability and human error during your calibration of certain gages, Calspex is equipped to conduct 
GR&R reports.  GR&R reports allow you to compare measured values, taken during several trials, to each other, 
rather than to master values.  Calspex then allows you to account for a certain degree of error whenever you 
calibrate the given gage.     
 
Calspex gives you the option of conducting a GR&R report during the calibration process itself or independently.  
Please refer to The GRR Tab for more information.   
 
Conducting Independent GR&Rs 
When you click Tools in the main menu and select Gage R&R, an entire sub-menu pops up, devoted to GR&R 
reports.  Here you can: 

 Begin a new GR&R report 
 Open or close an already existing GR&R report 
 Save a GR&R report  
 Print a GR&R report   

 
To conduct a GR&R report: 
Step 1: Click Tools in the main menu and select Gage R&R.  Then click the New option.  Notice you have 

retrieved the Gage R&R Form window and a corresponding GR&R flowchart. 
 

 
 
    Figure 37: Gage R&R Form Window 

 
Step 2: Click inside the Company field and enter the company name.  Tab to the other fields and enter all desired 

information.  Then click Next. 
 
Step 3: Determine the number of samples—that is, the number of measurements—you want to take.  
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         Figure 38: GR&R Parameters 
 

Use the arrow buttons to the right of the Number of Samples field to increase or decrease the number.  
You can also click inside the field itself and type in the desired number.  (Values can range from 1 to 10). 
 

Step 4: Determine the number of trials—that is, the number of times you want to take the measurements.  Use 
the arrow buttons to the right of the Number of Trials field to increase or decrease the number.  You can 
also click inside the field itself and type in the desired number.  (Values can range from 1 to 3). 

 
Step 5: Tab to the Operator Names dialog box and enter the names of the operators.  You must have at least 

one name and not more than three.  Click Next. 
 

Notice that you have retrieved a window entitled Values for (the name of the operator).  Notice also 
that the number of trials you selected is represented by tabs near the bottom of the window. 
 

 
 
Figure 39: GR&R Values Window 

 
 Step 6: Have the first operator enter a measured value in the Value field, then press the Add Value button.  

Repeat this process for all samples.   
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Values can be edited after all samples have been taken.  Simply click on the value you want to 
change and typing the updated measurement in the Value field.  Then click the Edit Value button. 
 

Step 7: If you have more trials to enter, click the appropriate tab to do that trial.  Once all samples for all trials 
have been taken, click the Next button.   

 
Step 8: Repeat the above process for all operators and all trials.  When you have completed all the trials, 

Calspex displays the Gage R&R value. 
 
Step 9: Save the GR&R file when prompted. 
 
Conducting GR&Rs within a Calibration Report 
If you have told Calspex to account for GR&R information in your definition of a particular gage, you will be prompted 
for GR&R information during the calibration report.   
 

 
 
     Figure 40: Gage R&R Info Window 

 
When prompted for GR&R information, you can do one of two things: 

 Use an already existing GR&R file.  Click the button displaying binoculars and select the GR&R file you 
want to use.  Use the Update Val button to make the GR&R value appear in the box. 

 Conduct a new GR&R report, then and there.  Click the New Report button and conduct a GR&R report 
by following the steps outlined above in Conducting Independent GR&R Reports. 

 
Ensure that the Use GRR Information check box is checked. 
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Printing 
Calspex allows you to create three types of printed reports:  

 Short Form Reports: This type of printed calibration report displays the gage’s status, not the numerical 
data.  

 Long Form Reports:  This type printed calibration report displays the gages status, accompanied by 
numerical data. 

 GR&R Reports: This type of printed report displays the results of a given GR&R report, accompanied by 
an explanation of how Calspex calculates the GR&R value.   

 
Calspex also allows you to batch print multiple reports at once.  Before printing a calibration report, however, it is 
advisable to use the Print Preview feature. 
 
      
  Print Button      Print Preview Button 
Using Print Preview  
Calspex Print Preview feature is useful in that it allows you to see how a calibration report will look on the printed 
page.   
 
To preview a report: 
Step 1: Retrieve the desired report if it is not already displayed on your screen. 

Step 2: Click the fifth button in the toolbar, or click File in the main menu and select the Print Preview option. 
  

The type of calibration report displayed (Long Form or Short Form) depends upon the selection 
made in the Options tab of Calspex Preferences.  Please refer to The Options Tab for more 
information. 
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          Figure 41: Calibration Report Print Preview 
 

Step 3: Click on the drop-down box at the top of the window to increase or decrease the magnification of the 
report displayed.  Use the scroll bar to view the entire document. 

 
Step 4: Click the Print button if you want to print the report immediately.  Otherwise, click the Close button. 
 
Printing a Report  
Once you’ve previewed your report, you’re ready to print it.  Simply follow these steps: 
 
For a calibration report: 
Step 1: Click the fourth button in the toolbar.   
 

The type of report printed (Long Form or Short Form) depends upon the selection made in the 
Options tab of Calspex Preferences.  Please refer to The Options Tab for more information. 

OR 
Step 1: Select File from the main menu and choose the type of report you wish to print. 

 Print Long Form 
 Print Short Form 
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Step 2: When presented with the Print window, specify the number of copies you want to print by clicking inside 

the Copies field and entering a number.  Then click OK or press the Enter key.  
 
For a GR&R report: 
Step 1: Click Tools in the main menu and click Gage R&R.  Then click Print from the pop-up menu.  

OR 
Step 2: Click the Print button in the toolbar   ensuring that the GRR flowchart is active on your screen. 
 
Step 3: When presented with the Print window, specify the number of copies you want to print by clicking inside 

the Copies field and entering a number.  Then click OK or press the Enter key. 
 

You can also access the traditional Windows Print Setup feature.  Simply click the File in the main 
menu and select Print Setup. 
 

Printing Multiple Calibration Reports 
Calspex provides you with the option of batch printing multiple calibration reports.  Simply follow these steps: 
 
Step 1: Click Tools in the main menu and select Batch Print.  Notice you have retrieved the Batch Print window. 
 

 
          
Figure 42: Batch Print Window 

 
Step 2: Your calibration files are listed for you in the box in the upper right-hand corner of the window.  Simply 

click and drag those you want to print to the box in the lower half of the window. 
 

To drag several files at once, simply hold down the Control key and select all the files you want to 
print.  Then click and drag to the lower box, bringing all the files with you.  
 

Step 3: Click the Print button. 
 

You can also access the traditional Windows Print Setup feature.  Simply click the File in the main 
menu and select Print Setup. 
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Launch other modules from Calspex 
Launching other programs from Calspex is easy.  If there are certain programs you always want to launch 
simultaneously with Calspex, you can do so in the Options tab of Calspex Preferences.  Please refer to The Options 
Tab for more information. 
 
To launch the Recall Database from Calspex: 
Step 1: Click this button in the toolbar.   
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